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1 Introduction

The ontology of soil properties and processes (OSP) mainly describes soil prop-
erties and processes, as well as how they affect each other. For example, the
strength of soil is influenced by the water content of it. The OSP ontology
reuses and specifies some high-level classes in the Semantic Web for Earth and
Environmental Terminology (the SWEET ontology) [7], which is developed by
NASA and widely adopted and extended. The OSP ontology is developed using
the NeOn methodology [10]. It is created manually and written in OWL 2 Web
Ontology Language Manchester Syntax [5], which is based on description logic
(DL) [3]. The DL expressivity of the ontology is SRZ, allowing transitive rela-
tions and inverse relations®. These relations are very useful when inferring new
information from the ontology using reasoning in description logic. The OSP
ontology contains 592 concepts and 2243 relation statements (logical axioms).
The concepts and relation statements are created based on the knowledge of
domain experts, the SWEET ontology [7] developed by NASA, English dictio-
naries [1, 2] and a textbook ‘Principles of Soil Physics by Rattan Lal and Manoj
K. Shukla, 2004’ [6]. The soil properties and processes described in the ontology
have agricultural, engineering and environmental applications, including asset
maintenance.

The OSP ontology is publicly available under the Creative Commons Attri-
bution 4.0 International (CC BY 4.0)2. This tutorial aims to help people to learn
how to view and query the OSP ontology using an ontology editor Protégé [8].

2 Installing Protégé and its Plugins

Protégé is a free open-source ontology editor. It can be downloaded from:
http://protege.stanford.edu. Protégé supports different platforms, includ-
ing Windows, Mac OSX and Linux. The detailed installation instructions for
installing the latest version of Protégé are available at: http://protegewiki.
stanford.edu/wiki/Install_Protegeb.

To query the OSP ontology, we need to install some reasoners within Protégé.
After opening Protégé, please follow the instructions below:

! To avoid confusion, we call ‘OWL object properties’ relations.
2 https://creativecommons.org/licenses /by /4.0/
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Go to the ‘File’ menu on the top-left corner.

Select ‘Check for plugins...’, then a window as shown in Fig. 1 will appear.
Select the three reasoners selected in Fig. 1 and click ‘Install’.

Wait about two or three seconds, then a message will pop up saying ‘Updates
will take effect when you next start Protege’.

Close and restart Protégé.

After installing the reasoner plugins, one should be able to see their names under
the ‘Reasoner’ menu.

| | £| Automatic Update u ]
|| Install MName Current version Available version H
Change Tracker 20.2
T0 Rk AdevebeedOWE e | 43
v FaCT++ reasoner 164
jeel 0.23.2
Ontop OBDA Protege Plugin 1171
OWL Difference 6.0.2
v Pellet Reasoner Plug-in 220
Snap 5PARQL Query 41.0
SWRLTab Protege 5.0+ Plugin 1.0.0.beta-19 1.0.0.beta-52

Author: Department of Computer Science, University of Oxford
License: http://www.apache.org/licenses/LICENSE-2.0.txt
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The ELK Reasoner team is pleased to announce
the ELK Protege plug-in 0.4.3 release!

ELK is an entology reasoner for the QWL 2 EL profile, currently with some
limitations, For further information see

http://elk.semanticweb.org/

Changes in this version:

Always check for updates on startup.

Install Mot now

Fig. 1. Installing Protégé reasoner plugins
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3 Viewing and Querying the OSP ontology using Protégé

The OSP ontology is stored in the file Soil-Property-Process.owl. Open it using
Protégé (go to the ‘File’ menu, click ‘Open’, locate and select Soil-Property-
Process.owl), the window shown in Fig. 2 will appear. The window displays in-
formation about the scope, purpose and knowledge sources of the OSP ontology,
as well as numbers of classes and axioms in it.

By using the ‘Entity’ tab, we can see the class hierarchy and relation hierar-
chy in the OSP ontology (Fig. 3). For a selected class, its usages and annotations
are displayed on the right side of the window. For example, the usages of the
class SoilStrength 3 are shown in Fig. 4 and Fig. 5, where SoilStrength is classi-
fied as a SoilPhysicalProperty and its relationships with several other properties
and processes are defined. Fig. 6 shows the annotations of the class SoilStrength.
These annotations indicate the knowledge sources used for defining it. The page
numbers, table names, figure names, chapter or section names in the annota-
tions are provided to help users locate explanations or evidence in the textbook
‘Principles of Soil Physics by Rattan Lal and Manoj K. Shukla, 2004’ [6].

The DL Query tab (go to the ‘Window’ menu, go to the ‘Tabs’ list, tick ‘DL
Query’) can be used to query the OSP ontology. Before executing a query, one
should select and start a reasoner (e.g. go to the ‘Reasoner’ menu, select ‘ELK
0.4.3’, and click ‘Start reasoner’). Ticking the ‘Subclasses’ on the right and ex-
ecuting the query ‘hasImpactOn some SoilStrength’, we will get a list of all the
subclasses of the class expression ‘hasImpactOn some SoilStrength’, as shown
in Fig. 7. For each class C in the list, the relation statement ‘C' hasImpactOn
SoilStrength’ can be inferred from the OSP ontology using DL reasoning. The
list in Fig. 7 consists of 173 classes, which fall into different categories, such as
Property, Process, Substance and HumanActivity. To obtain a list of soil proper-
ties which hasImpactOn SoilStrength, we execute the query ‘(hasImpactOn some
SoilStrength) and SoilProperty’, as shown in Fig. 8. (Note that owl : Nothing is
the default bottom class in OWL. It is interpreted as an empty set and it is
a subclass of any class.) Each class in the list of query results has a ‘question
mark button’ on the right, which is used to display explanations about why the
class is in the list. Clicking the question mark button, one will see a message
box as shown in Fig. 9. It tells how many explanations are found. When all the
explanations are found, a window as shown in Fig. 10 will be displayed auto-
matically. However, it is possible that a large number of explanations exist and
it takes relatively long time to calculate all of them. In such cases, we may ‘Stop
searching’, once enough explanations are found.

Fig. 10 displays explanations for ‘SoilMoisture Content is a kind of SoilProperty’
and ‘SoilMoistureContent hasImpactOn SoilStrength’. In Explanation 1, State-

3 The class SoilStrength can be found by using ‘Search’ on the top-right corner, or going
down the class hierarchy from Property, to SoilProperty, to SoilPhysicalProperty, to
SoilStrength.

4 Some ELK warning messages will pop up to tell you the limitations of the ELK
reasoner. Tick ‘Do not show further messages of this kind in this session’ or ‘Do not
show this message again in this session’ and click ‘OK’.
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ments 1-3 justify ‘SoilMoistureContent is a kind of SoilProperty’ and Statements
4 and 5 justify ‘SoilMoistureContent hasImpactOn SoilStrength’. In Explanation
2, Statements 1-4 justify ‘SoilMoistureContent is a kind of SoilProperty’ and
Statements 1 and 5 justify ‘SoilMoistureContent hasImpactOn SoilStrength’.

4 Summary and Recommended Tutorials

This tutorial explains how to install and use Protégé and its reasoner plugins to
view and query the OSP ontology. Like other OWL ontologies, the OSP ontology
can be edited or extended using Protégé or other editors. We recommend the
following tutorials for people who would like to learn more about Protégé and
OWL 2.

For Beginners: The Protégé OWL tutorial [4] provides a step-by-step guide
to modelling in OWL using Protégé. It is available at: http://owl.cs.
manchester.ac.uk/publications/talks-and-tutorials/protg-owl-tutorial.
For Advanced Users: The Manchester Family History Advanced OWL Tu-
torial [9] provides a comprehensive step-by-step guide to modelling family
history using advanced OWL 2 features. It is available at: http://owl.cs.
manchester.ac.uk/publications/talks-and-tutorials/fhkbtutorial.

Acknowledgments. This research is supported by EPSRC under grant no.
EP/K021699/1 which we gratefully acknowledge. We express thanks to Dr. Lijun
Wei and Dr. Qingxu Dou for providing comments and helping us improve the
first version of the tutorial.
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File Edit View Reasoner Tools Refactor Window Help

|® SoilPhysics (http://imash.leeds.ac.uk/ontologies/atu/5oilPhysics.owl) 'H Search... |

Active Ontology = | Entities = | Individuals by class = | DL Query J-c|

Ontology metrics:

[v]

Ontology IRI http://imash.leeds.ac.uk/ontologies/atu/SoilPhysics.owl Metrics
Ontology Version IRI HAxiom 3916

Legical axiom count 2243

Annotations Z Declaration axiom... 620
Scope Class count 592
The ontology mainly describes soil physical properties and processes, as well as how they affect each Object property co...16
other.
dedate L
April, 2016 DL expressivity SRI

Acknowledgment Class axioms

This research is supported by EPSRC under grant no. EP/K021699/1 which we gratefully acknowledge. SubClassOf 2148

EquivalentClasses 74
KnowledgeSource

DisjointClasses 1
The knowledge sources ofthis ontology include:
- knowledage explained in the textbook: Principles of Soil Physics, by Rattan Lal and Manoj K. Shukla, Hidden GCI Count 126
2004,
Object property axioms

- knowledge of domain experts

- The SWEET ontology (hitps.isweet.jpl.nasa.gov)

- online dictionaries: Cxford Dictionary (hitp:fwww.oxforddictionaries.com) and Cambridge Dictionary
(http:Aidictionary.cambridge.org)

SubObjectPropert... 4

InverseObjectProp... 4

Forthe relation statements (OWL logical axioms) in the ontology, we add annotations to indicate their
knowledge sources. If a statementis hased on knowledge explained in the texthook, we provide page
numbers, takle names, figure names, chapter or section names to help users locate its explanations. TransitiveObjectPr... 6

Thefile Soil-Property-Process.owl is created manually. Opening the file using a text editor, one can find
the annotations of a relation statement easily.

Description

Although much care has been taken to provide accurate information, neither the ontology creator

(authar) nor the University of Leeds, nor anyone else associated with this ontology, shall be liable for
any loss, damage, or liability directly or indirectly caused or alleged to be caused by this ontology. The .
material contained herein is notintended to provide specific advice or recommendations for any SubPropertyChain... 6
specific situation.

Data property axioms
Furpose

To describe soil properties and processes, as well as their relationships.

License
Creative Commaons Aftribution 4.0 International (CC BY 4.0)

decreator
Heshan Du, University of Leeds

[«]
[«]

Individnal avinme

Ontology imports | Ontology Prefixes | General class axioms

Imported o

Mo Reasoner set. Select a reasoner from the Reasoner menu Show Inferences

Fig. 2. Opening the OSP ontology using Protégé
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Active Ontology = ‘ Entities = | Individuals by class = | DL Query = ‘

|C\ass hierarchy | Class hierarchy (inferred) |

Class hierarchy: owl:Thing

%]

u nActivity
p-- @ Phenomena
r

¥ PlantProcess
»— @ SoilProcess

GeneralProperty
MeteorologicalProperty
SoilProperty

1 SoilChemicalProperty

) SoilPhysicalProperty
p-- 0 SoilSpatialProperty
WaterProperty
SoilFunction
SoilAgriculturalFunction
SoilEngineeringFunction
SoilEnvironmentalFunction
@ soilStructureIndex
@ Substance

MEEE

Asserted ¥

| Individuals by type

I Annotation property hierarchy

| Object property hierarchy

=

Data property hierarchy

by

V- mowl:topQbjectProperty

Y

- mby

- mfrom

-~ m hasImpactOn
- mhasPart

m hasPossibleCause
®m hasPossibleEffect

- minfluencedBy

- minverseProcessOf
- mmeasuredBy

- mmeasures

- mmof

= partOf

Fig. 3. Class hierarchy and relation hierarchy in the OSP ontology
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Active Ontology = | Entities = | Individuals by class ><| DL Query = |

Class hierarchy (inferred)

Class hierarchy

Class hierarchy: SoilStrengt MBEEE

%8 B

----- © SoilPermittivity

p—- 0 SoilPhysicalCapacity
----- © soilPhysicalQuality
----- @ SoilPlasticity

----- © SoilSensitivity

0 SoilStability

@ Soilstrength

----- @ SoilStructure

= SoilTemperature

@ SoilTexture

© SoilThermalProperty
----- @ SoilTilth

----- © SoilTrafficability

----- © SoilTransportability
----- @ SoilType

@ SoilvaporPressure

@ SoilViscosity

@ SoilVolume

----- @ SoilStructuralResilienc{ |
----- @ SoilStructuralStability

§-- 0 SoilswellShrinkProperi

.. nillWatarDhucicrsDenn
4 ;

Asserted ¥

----- © SoilNutrientAvailability ~
----- = SoilPackingArrangemel
b 0 SoilParticlePhysical Pra
----- © SoilPenetrationResistal
p-- = SoilPermeability = Soil

p—- 0 SoilPorePhysicalPropel

p-- 0 SoilSolutePhysicalProp

-

Datatypes

Annotation property hierarchy

Individuals by type

Data property hierarchy

Object property hierarchy

Object property hierarchy:
ar Al — R

v mowl:topObjectProperty

® hasImpactOn

m hasPart

m hasPossibleCause
m hasPossibleEffect
m influencedRv

Asserted ¥

-

Class Annotations | Class Usage |

SoilStrengtl

Shows: vl thisly! disjoints/v named sub/superclasses

© SoilshearStrength

@ SoilShearStrength SubClassOf SoilStrength

SoilStability

@ Soilstability SubClassOf influencedBy some SoilStrength

SoilStrain

© Spilstrain SubClassOf hasIlmpactOn some SoilStrength

¥-- 0 SoilStrength

© SoilStrength SubClassOf influencedBy some SoilParticleSizeDistribution
© Spilstrength SubClassOf hasImpactOn some SoilErodibility

@ Soilstrength SubClassOf influencedBy some SoilClayContent

@ Soilstrength SubClassOf influencedBy some SoilCohesion

@ Soilstrength SubClassOf influencedBy some SoilStructure

@ SpilStrength SubClassOf hasImpactOn some SoilBearingCapacity

© SoilStrength SubClassOf influencedBy some SoilParticleSpecificSurfaceArea

© Spilstrength SubClassOf influencedBy some SoilBulkDensity

© Spilstrength SubClassOf hasImpactOn some SoilTrafficability

@ SoilStrength SubClassOf SoilPhysicalProperty

@ Soilstrength SubClassOf influencedBy some SoilOrganicMatterContent
@ Soilstrength SubClassOf influencedBy some SoilAggregateStrength
© SpilStrength SubClassOf hasImpactOn some SoilStability

© Spilstrength SubClassOf influencedBy some SoilClayMineral

© Spilstrenagth SubClassOf influencedBy some SoilMoisturePotential
@ Soilstrength SubClassOf measuredBy some ModulusOfRupture

@ SoilStrength SubClassOf influencedBy some SoilAggregatesSize

@ Soilstrength SubClassOf influencedBy some SoilAdhesion

@ SpilStrength SubClassOf hasImpactOn some SoilSlopeStability

© SoilStrength SubClassOf influencedBy some SoilPorosity

© Spilstrenagth SubClassOf measuredBy some SoilPenetrationResistance
@ SoilStrength SubClassOf hasImpactOn some SoilAggregateStability
@ SoilStrength SubClassOf measuredBy some SoilRelativeDensity

® SoilStrength

@ SpilStrength SubClassOf influencedBy some SoilMoistureContent

© SoilStrength SubClassOf influencedBy some SoilPoreSize

© Soilstrenagth SubClassOf hasImpactOn some FoundationStrength
@ Spilstrength SubClassOf hasImpactOn some SoilCompactability

SoilTrafficability

© SoilTrafficability SubClassOf influencedBy some SoilStrength

V- & SoilWaterContent

© SoilWaterContent SubClassOf hasImpactOn some SoilStrength

Fig. 4. Usages of SoilStrength: View 1

MBEEE

4]
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Active Ontology = | Entities = | Individuals by class = | DL Query = |

Class hierarchy (inferred) Class Annotations | Class Usage |

Class hierarchy age: SoilStrength e
Class hierarchy: SoilStrength Show: [v! thislv disjointslv] named sub/superclasses

% ﬂ E Found 532 uses of SoilStrenagth E
~ ¥e

----- © SoilNutrientAvailability ~ FoundationStrength . .

_____ & SoilPackingArrangeme @ FoundationStrength SubClassOf influencedBy some SoilStrength
p-- 0 SoilParticlePhysicalPra
----- ) SoilPenetrationResista
b & SoilPermeability = Soil
----- @ SoilPermittivity

p-- 0 SoilPhysical Capacity
----- © SoilPhysicalQuality
----- © SoilPlasticity

p- 0 SoilPorePhysicalPropel
----- O Soilsensitivity
© SoilSolutePhysicalProp
© Soilstability
----- ¥ SoilStructuralResilienc{ |
@ SoilStructuralStability
- {0 SoilStructure

- SoilswellShrinkProper|
- & SoilTemperature

----- 0 SoilTexture

p- 0 SoilThermal Property
----- @ SoilTilth

© SoilTrafficability

@ SoilTransportability
SoilType —

PlantGrowth
© PlantGrowth SubClassOf influencedBy some SoilStrength

RootGrowth
© RootGrowth SubClassOf influencedBy some SoilStrength

SeedlingEmergence
© SeedlingEmergence SubClassOf influencedBy some SoilStrength

¥ & SoilAvaila bleWaterCapacity
© SoilAvailableWaterCapacity SubClassOf dependsOn some SoilStrength

@ SoilBearingCapacity
@ SpilBearingCapacity SubClassOf influencedBy some SoilStrength

SoilCompactability
@ SoilCompactability SubClassOf influencedBy some SoilStrength

SoilCompaction
© SoilCompaction SubClassOf influencedBy some SoilStrength

* 505“"?90"3"&55““! @ SoilCompaction SubClassOf measuredBy some SoilStrength
----- @ SoilViscosity
----- @ Soilvolume —
Beai - - @ SoilCrackingNumber

[ ]

Datatypes

Annotation property hierarchy
Individuals by type

Data property hierarchy

© SoilCrackingMumber SubClassOf influencedBy some SoilStrength

SoilDeformation
© SoilDeformation SubClassOf influencedBy some SoilStrength

SoilDrainage
@ SoilDrainage SubClassOf hasImpactOn some SoilStrength

Object property hierarchy

Object property hierarchy:

SICE g
- |eEiE @ 50ilDrying SubClassOf hasImpactOn some ScilStrength

owl:topObjectProperty |«

by SoilErodibility

from @ SoilErodibility SubClassOf influencedBy some SoilStrength
hasImpactOn

hasPart
hasPossibleCause
hasPossibleEffect

¥ minfluencedBy -

[4]

Fig. 5. Usages of SoilStrength: View 2
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Active Ontology = | Entities x | Individuals by class = | DL Query = |

| Class hierarchy | Class hierarchy (inferred) | | Class Annotations | Class Usage |
Annotations: Soilstrength IEEE
EE @ Annotations Z
----- & SoilPackingArrangement = SoilParticle| «| Description
- SoilParticlePhysicalProperty (Table 3.18).
) SoilPenetrationResistance
- = SoilPermeability = SoilIntrinsicPermea TABLE 3.19 Engineering Applications [3.3.1 Texture and Soil Processes,
O SoilPermittivity p.76]
- SoilPhysicalCapacity
- 0 SoilPhysicalQuality Description
© SoilPlasticity | [2.1.3 Specific Surface Area, p.42]
© SoilPorePhysicalProperty
© SoilSensitivity Description
b 0 SoilSolutePhysicalProperty
§ SoilStability [7.2 STRESS-STRAIMN RELATIOMSHIP, p.177]
SoilStructuralResilience . Description
@ SoilStructuralStability [7.6 SOIL STRENGTH, p.181-182]
- (0 SoilStructure
- SoilSwellShrinkProperty Description
€ SoilTemperature [7.6 SOIL STRENGTH, p.181]
- SoilTexture
- SoilThermalProperty Description
- SoilTilth
. @ SoilTrafficability [7.6 SOIL STRENGTH, p.182]
© SoilTransportability H .
- @ SoilType Description
- ) SoilVaporPressure [7.6.2 Factors Affecting Soil Strength, p.182]
- SoilViscosity =
— |_ Description

| [»

[4]

[7.6.2 Factors Affecting Soil Strength, p.183]

Individuals by type |Annotation property hierarchy | Datatypes
Object property hierarchy | Data property hierarchy Description
Object property hierarchy: [7.6.2 Factors Affecting Soil Strength, p.184]

= | = | Description

[Chapter 7. Soil Strength and Compaction, p.175]

Description
[Penetration Resistance, p.1989]

hasPossibleCause
hasPossibleEffect
influencedBy

inverseProcessOf

Description

measuredBy

measures TABLE 1.1 Soil Physical Properties and Processes That Affect
Agricultural, Engineering, and Environmental Saoil Functions

Description
From a domain expert

Description
TARI F 4 R Some Indices of Snil Structure Rased an Pranerties Othar

[«]

Fig. 6. Annotations of SoilStrength
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Query (class expression)

hasImpactOn some SoilStrenagth

| Execute | | Add to ontology

Query results
Subclasses (173) ["] Direct superclasses

@ AntecedentSoilMoistureContent
@ Biochannel

[ Superclasses

["] Equivalent classes

' Biomass [] Direct subclasses
@ Clay Subclasses
@ CoarseSand [] Instances

@ ConservationTillage

¥ ConservativeSolute

© ControlledDrainage

¢ ConventionalDrainage
@ Crop

@ CropResidueMulch

@ DegreeOfSaturation
@ Earthworm

@ Evapotranspiration

@ FineSand

@ Flood

@ FluxControlledWaterInfiltration
@ Frost

¥ Grass

-

Fig. 7. DL Query: all subclass of the class expression ‘hasImpactOn some SoilStrength’
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Query (class expression)
(hasImpactOn some SoilStrength) and SoillProperty

(| Execute | | Add to ontology |

Query results
Subelasses (25) Z [ Direct superclasses
@ AntecedentSoilMoistureContent ["] Superclasses
@ DegreeOfSaturation [ Equivalent classes
@ LeastLimitingWaterRange [ ] Direct subclasses
@ LiquidRatio Silrd ezmes
® owl:MNothing

[ ] Instances
@ PermanentWiltingPoint

© PlantAvailableWaterContent

@ SoilClayContent

= SoilClayMineral

= SoilClayMineralogy

¢ SoilFieldMoistureCapacity

© SoilGravimetricMoistureContent
@ SoilimmobileWaterContent

© SoilMobilewaterContent

= SoilMeistureContent

© ScilParticleSize

O SoilParticleSpecificSurfaceArea
@ Soilsalinity

@ SoilStructure

-

Fig. 8. DL Query: all subclass of the class expression ‘(hasImpactOn some SoilStrength)
and SoilProperty’

o ™
<¢ Computing explanatiun- E

Computing explanations. Found 2

[ |

Fig. 9. Computing explanations
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¢, Explanation for So

(@ Show regular justifications @ Al justifications
) Show laconic justifications ) Limit justifications to

Explanation 1 || Display lzconic explanation

Explanation for: SailMoistureContent SubClassOf SoilProperty and (hasimpactOn some SaoilStrength)
SoilMoistureContent SubClassOf SoilWaterPhysicalProperty MO
SoilwaterPhysicalProperty SubClassOf ScilPhysicalProperty ALL
SoilPhysicalProperty SubClassOf SoilProperty ALL
SoilMoistureContent EquivalentTo ScilwaterContent ALL

SoilWwaterContent SubClassOf hasImpactOn some SoilStrengthy ALL

Explanation 2 || Display lzconic explanation

Explanation for: SailMoistureContent SubClassOf SoilProperty and (hasimpactOn some SaoilStrength)
SoilMoistureContent EquivalentTo ScilWaterContent ALL
SoilWaterContent SubClassOf SoilWaterPhysicalProperty [0]e]
SoilwaterPhysicalProperty SubClassOf SoilPhysicalPropertys L
SoilPhysicalProperty SubClassOf SoilProperty ALL
SoilWwaterContent SubClassOf hasImpactOn some SoilStrengthy ALL

Fig. 10. Explanations for ‘SoilMoistureContent is a kind of SoilProperty’
‘SoilMoistureContent hasImpactOn SoilStrength’.

and




